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Who is our audience?

1. KanCare applicants and members

2. Friends and family assisting them

3. Staff from other organizations

4. KanCare Ombudsman staff and volunteers
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What our Audience Does Not Need

A springboard from which they can do their 

own research:

•Pages full of dense text, technical terms and 

complex sentences

•Embedded links to more pages of dense text
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What does our audience need?

Easy to follow information covering only the 

topic that is important to them:

•So they can find what they need quickly

•Understand what they find

•Use what they find to meet their needs
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KanCare Ombudsman Accessibility Guidelines

Please follow the specific guidelines outlined 

in this lesson when creating resource and 

educational materials for KanCare applicants, 

members and those who assist them.
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The 4 Parts of Accessible Resources: 

I. Clear and readable

II. Easy to follow and understand

III. Readable by assistive technologies

IV. Available in alternative formats
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What is readability?

• Readability means producing 

materials that are as clear and 

readable as possible. 

• It is the first step in making our 

information accessible to 

everyone, no matter how much 

vision they have. 

7



Part I.  Readability Techniques

❑Numerals

❑Color and Contrast

❑Font

❑Emphasis

❑Letter Spacing

❑Line Spacing

❑Columns

❑Headings

❑Paper Finish

❑Wide Margins
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Use numerals instead of spelling out numbers 

Not five
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Color and Contrast

•   Use high-contrast colors for text 

and background. 

•   Keep in mind that dark 

backgrounds  make it difficult for 

some people to read the text.

•   Best practice:  Printed material is 

most readable, black on white.
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For example, black 
text on a yellow 

background.

Or white text on a 
dark blue 

background.



Font Color 

If using colored text, restrict it to things like:

• Titles and headings

• Emphasized material
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Printed material is 
easiest to read in 
black and white.



Font Color 

Check that colors used will photocopy 

well in black and white (when applicable).
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Font Size

• Keep text large

• Bigger is better

• Consider your audience and type of 

resource when choosing font size
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What font size do I use on documents?

• Keep average print, font size between 12-16 

• Keep large print, font size between 16-18

• Not all font sizes are equal (for example, a 16 

point font may be fine in Arial, but will appear 

too small in Calibri).
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What font size do I use on PPTs?

• Headings font size should be between 36-44

• Body content font size should be no smaller than 24 if meant to be read 

up close

• Larger than 24 is good, but be consistent

• If it will be presented in front of a large audience, make sure the person in 

the back seat will be able to  read it

• Notes section font size should be no smaller than 12 points, with headers 

between 18-20 points
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What font styles should I use?
 

Choose standard fonts with 

easily recognizable upper and 

lower case characters. 

A few good choices are:

• Arial

• Calibri

• Georgia

• Garamond
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What font styles should I avoid?
 

Some fonts can be complicated and  difficult to read.

For example:

• Decorative fonts (with lots of swirls and curls)

• Script fonts

• Italics (similar to script type fonts)

Decorative fonts
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Script

Italics



Use font style to separate types of content

Use font style to clearly differentiate headings from body text.  For maximum 

readability, use one font style for headings, and another for body text.
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Recommended:

•Use a sans serif font for headings

•Use a serif font for the body text

•Be consistent throughout the material



What is a Serif ?

19

•Serifs are the small lines attached to the end of a stroke in a letter or 

symbol.

•With the serif, the brain does not need to spend as much time 

identifying the letter because the shape is more distinctive.

•Using serif font makes it easier to read through a lot of content more 

quickly.  



When do I use serifs vs. sans serifs?

Sans serifs – for headings

•Better Legibility – easier to discern from far away

•Good for eye-catching headlines, PowerPoint, web 

content

Serifs – for body text

•Better Readability - easier to read through more quickly

•Good for the body of documents with lots of text 20

Sans serif

Serif



What are some suggested font style pairings?

Headings Body text 

Arial Times New Roman

Helvetica Georgia

Gill Sans Garamond

Calibri Light (Headings) Calibri (Body) - for digital 
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Font for Headings

•Avoid using all caps

•Set headings in bold

•Justify to the left margin
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What font should I use when emphasizing a word 
or passage?

Recommended:

• larger 

• Bold

• color

Not recommended:

• UPPERCASE 

• underline

• italics 
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Poor Emphasis Techniques

• ALL CAPS  and underlining draw the reader’s 

attention, but they make it harder to read.  

• All caps is considered SHOUTING in a text or 

online.

• Italicized fonts as these are difficult to read 

quickly.
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Font Consistency

•The consistency in font characteristics 

used throughout your writing 

determines how easy or tough it may be 

to read.

•Changing font sizes, styles and colors 

throughout a presentation can distract 

and confuse some readers.
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Avoid using more than 4 type faces on one page.

For example:

1. Be consistent with selected headline font throughout.

2. Be consistent with chosen body content font  throughout.

3. Use bold, color and different sizes of those fonts for captions, subheadings 

and emphasis.
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Font Spacing

• Do not crowd your text.

• Keep a wide space between letters
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Line Length (Measure)

• The measure is the length of a line of type. 

• To a reader’s eye, long or short lines can be tiring and distracting. 

• A long measure disrupts the rhythm because the reader has a hard time 

locating the next line of type. 

• The only time a narrow measure is acceptable is with a small amount of 

text. 
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Measure Examples -  Good, Too Long, Too Short

Here is an example of what good and bad 

leading looks like from Matthew Butterick’s 

book, Butterick’s Practical Typography.
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https://practicaltypography.com/line-length.html
file:///C:/Users/Lisa/Desktop/Cult Comp 6-13-18/Combo Lesson 10-14-18/8 Simple Ways to Improve Typography In%C2%A0Your Designs _ AisleOne.html


Leading (Line Spacing)

• Leading is the space between the lines, and it 

plays a big role in readability. 

• You want to use wide enough spaces so the 

information is clear, but not so loose that the 

text is hard to follow.
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Leading Examples - Good, Too Tight, Too Loose

Here is an example of what good and bad 

leading looks like from Matthew Butterick’s 

book, Butterick’s Practical Typography.
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https://practicaltypography.com/line-length.html
file:///C:/Users/Lisa/Desktop/Cult Comp 6-13-18/Combo Lesson 10-14-18/8 Simple Ways to Improve Typography In%C2%A0Your Designs _ AisleOne.html


What leading is recommended?

• Single-spaced  text is dense and hard to read. 

• But 1.5 spacing is often looser than optimal.

• Stay within this range:  1.03-1.5

• Recommended:  Use between 2-5 points over font 

size (for lines with more text) to 1.5 spacing between 

lines (only for lists).
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How do I calculate the correct leading?

The following is a calculation on how to set the space between the 

lines to be 2-5 points over font size. 

For example, for font size is 26:

• 2 points over font size is 28 (minimum)

• 5 points over font size is 31  (maximum)

Leading Range for 24 font size:

• Minimum:  2 points over 26:  1.08  (28/26 = 1.08)  

• Maximum:  5 points over 26:  1.20  (31/26 = 1.2) 34



How to set appropriate leading?

Steps to set appropriate leading:

1. Highlight text on page

2. Right mouse click

3. Select Paragraph

4. From the Line Spacing dropdown box, 

choose Multiple

5. Enter your calculated leading value (stay 

between 1.03-1.5). 



What factors affect leading?

• Many factors affect leading: font style, size, weight, 
case, measure, word spacing, etc. 

• The longer the measure (line length), the more 
leading is needed. 

• The larger the font size, the less leading is required. 

• Since there are so many factors that can affect 
leading, use your best judgment based on these 
guidelines.

• Stay within range:  1.03-1.5 (Line Spacing menu set 
to Multiple).
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Paragraph Spacing

• The spacing between paragraphs should be larger than the 
spacing between lines.

• Space between paragraphs signals the start of a new 
paragraph, or new idea.  

• You want the space to be large enough to be noticed.

• The larger the font size, the more space you’ll  need 
between paragraphs to make a visible difference.
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How do I set paragraph spacing?

1. Highlight the text on the slide

2. Select the Paragraph Dialogue Box

3. Select a number that will make the 

difference between paragraphs easy to 

detect.

For example:

Select 6 in the After box.  If that’s not 

enough, you can add some to the Before box 

as well.  You want the space to be wide 

enough to be noticed. 38



Columns

❑  Separate long lists of text 

into columns to make them 

easier to read.

❑  Columns require less eye 

movement and less peripheral 

vision. 
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Paper Finish 

•Avoid watermarked or patterned backgrounds 

that can reduce readability of text.

•Matte or non-Glossy finish can reduce glare.
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Use Wide Margins

41



11/5/2018 42



Part II.  Design that is Easy to Follow & Understand

❑Clean, simplistic and consistent layout 

❑Easy to follow

❑Easy to understand
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Clean, Simplistic, Consistent

❑Create a layout that is clean, simplistic and consistent 

❑Use design elements that make your writing easy to follow

❑Break up complicated information into small, easy-to-process chunks
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Create a clean, simplistic & consistent layout

•Use the same font across all the headings

•Don’t mix fonts within the body

•Limit images to 4-5 per page (1-2 per PPT slide)

•Keep images to the left of the writing

•Justify all text to the left (ragged right margins)

•Number the pages at the bottom right hand side
45



Is your layout consistent?

•Are headings consistent throughout (size, style, justification, color, etc.)?

•Is the body text consistent throughout (size, style, justification, color, etc.)?

•Is there consistent vertical and horizontal spacing between elements?

•Are images of the same family (photos, drawings, icons, etc.)?

•Does your document or presentation use the same color scheme throughout?

•Are navigational tools consistent throughout (color, placement, style)?
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Why is a consistent layout important?

•An inconsistent layout slows the reader down. 

•Consistent layout enables the reader to spend more time engaged in 

the content.
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Easy to Follow

❑Create a layout that is clean, simplistic and consistent 

❑Use design elements that make your writing easy to follow

❑Break up complicated information into small, easy-to-process chunks
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Design for Easy-Reading

•Dense, cluttered writing deters people from 

taking the time to read.

•When someone gets a dense, uninviting letter or 

notice, they often put it in a “read later” pile, even 

though they know they should read it right away.
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Design for Easy-Reading

•We want our writing to help people get the 

information with the least possible burden.

•In turn, they are more able to comply with 

requirements to get and keep their benefits.
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What design elements make writing easy to 
follow?

❑White space

❑Keeping the content together

❑Useful headings 

❑Tables 

❑Lists 
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What is white space?

•White space is empty space that enhances 

readability. 

•Don’t try to cram everything into one small area. 

•Use white space to let your content breathe. 

•It’s better to have more slides than not enough 

spacing between lines and paragraphs.
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How can white space make writing easier to follow?

•In place of dense cluttered text, whitespace helps 

create a balanced, easy  to read page where you can 

find what you need without being overwhelmed.

•White space can change the overall feel from scarily 

complex to laid-back and approachable.
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How to create more white space?  

•Increase leading

•Increase spacing between paragraphs

•Use only enough images to support the main idea

•Add more slides or pages; don’t try to cram it all in
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Keep the content to-
gether

•Finish a word on the same line.

•Finish a sentence on the same…
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Keep the content together

•Finish a word on the same line.

•Finish a sentence on the same page.

•Finish a paragraph on the same page.
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Useful Headings

• Help the reader to skim and scan

•Are concise and descriptive

•Focus on clarity over brevity

•Provide clear structure
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Useful headings are concise and descriptive

❑Question headings – most recommended; questions your audience ask

❑Statement headings – next best choice; should be very specific

❑Topic headings – okay too, but if too vague, they are not as useful and may 

even confuse the reader
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Useful headings focus on clarity over brevity

In the example below, the question headings in the right column are more 

informative than the topic headings on the left.
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Topic Headings Question Headings

Applications How to I apply for KanCare?

Appeals What is the appeal deadline?

Grievances Where do I submit a grievance?



Useful heading provide clear structure

Broad topic headings can help add additional structure to the document, but 

specific topic headings are a crucial design element for easy-reading.
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KanCare Applications

•Who may be eligible for KanCare?

•Where can I get an application?

•Where do I submit my application? 

•How will I find out if I have been approved?



Lists

Bullet point lists

• Help the reader to skim and scan

• Break up text and present information in 

a visually clear way

• Add white space for easy reading

• Help the reader focus on important 

material

Numbered lists

1. Help the reader understand steps 

in a process

2. Highlight priorities
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How do I make lists easier to read?

Your lists will be easier to read if you:

•Stick with standard circle or squared bullets (unless sequence or priority is being 

indicated).  If see importance for non-standard bullets, like diamonds or arrows, be 

consistent.

•Indent your lead-in sentence from the left margin (as I’ve done here).  Notice there 

is no bullet on the lead-in sentence).

•Use parallel construction - Make sure each of the bullets in a list can make a 

complete sentence if combined with the lead-in sentence.

•Use no more than 2-3 levels - Readers get lost when you use more than two or 

three levels in a document. If you find you need more levels, consider dividing your 

top level into more parts. 64



Tables

•Help the reader to skim and scan

•Give your document more white space

•Help your audience see relationships

•Make complex material easier to understand

65

If (situation) Then (consequence)

If the member requests continuation 

of disputed services within 10 calendar 

days of the Notice of Adverse Benefit 

Determination

A member will continue to 

receive those services without 

interruption until the hearing 

decision 
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Easy to Understand

❑Create a layout that is clean, simplistic and consistent 

❑Use design elements that make your writing easy to follow

❑Break up complicated information into small, easy-to-process chunks
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How do I make complicated information easy to 
understand?

1. Think through the questions your audience will likely have. 

2. Organize that information in a logical order, breaking it up into small 

chunks.

3. Develop your message one point at a time, taking the reader 

through the thinking process.
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How can I break it up to make it easier to 
understand?

1. Simple words and phrases

2. Strong, direct verbs

3. Avoid acronyms & abbreviations

4. Minimize jargon

5. Short, clear sentences

6. Short paragraphs

7. Short sections

8. Limited number of sections per page

9. Minimize definitions

10. Relevant examples & images
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Use Simple Words
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Say Don’t Say

drop discontinue

choose designate

need to is essential

must shall

change modify

later, next subsequent



Use the strongest, most direct form of the verb 
possible
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Say Don’t Say

Apply for KanCare. Complete an application for KanCare.



Use Active Voice

Active voice makes it clear who is supposed to do what.  It eliminates 

ambiguity about responsibilities.  
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Say Don’t Say

You must do it. It must be done.

You must submit your appeal to the 
MCO.

Your appeal must be submitted to 
the MCO.

The Clearinghouse will send you 
the letter.

The letter will be sent by the 
Clearinghouse.



Avoid Abbreviations

Write out the word instead of using an abbreviation.
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Say Don’t say

for example; such as e.g.

that is i.e.

street st.

number no.



Avoid Acronyms

•Use them only if they are important or convenient for your readers.

•If you must use an acronym, spell it out the first time you use it. 

•Make sure your readers know exactly what they mean.

•Convert as many as possible into words.  For example, convert St. into 

Street.

•But continue to use them if spelling them out would annoy your readers. For 

example, Kansas Department for Aging and Disability Services (KDADS).
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Avoid Jargon

•This does not mean that you should leave out necessary technical terms.

•But, make sure your language is as clear as possible. 

•If you have no way to express an idea except by using the technical term, 

make sure to define and explain the term.
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Minimize Use of Definitions

•Keep the definitions to a minimum.

•When possible, define a term where you use it.

•If possible, it is best to rewrite to eliminate the need for a definition.

76



Use Examples to Clarify

•Good examples can substitute for long explanations or definitions. 

•The more complex the concept you are writing about, the more you should 

consider using examples. 

•The best examples are relevant to the reader’s situation.
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Use Images to Clarify

•Good images, like examples, can also help to clarify complicated ideas.

•Use images that reinforce and complement your message.

•Images should help clarify the main point (not every detail).
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What type of images can I use?

•Photos, drawings, symbols, icons, etc.

•Images that you’ve paid for or have the rights to use

79



What is important about the image itself?

Images should be:

•Clear 

•Uncluttered (not busy)

•Age appropriate

•Up to date

•Consistently from the same family 
(photos, drawings, symbols, icons, etc.)
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Use the Same Terms Consistently

•You will confuse your audience if you use 

different terms for the same concept or object.

•For example, if you use the term KanCare 

member, continue to use this term throughout 

the material.

•Don’t substitute another term, such as KanCare 

consumer, later in the material.
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Hearing
Fair Hearing

State Fair Hearing

Administrative Hearing

Medicaid Hearing
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Chunking: Break down complex content into 
easy-to process chunks

•Complex sentences, long paragraphs and large sections can be 

confusing and discourage an audience from even trying to understand 

your material. 

•Instead of trying to “pack everything in," split topics up into logical, 

short sections and separate them with informative headings.  

•Then make it easy for the reader to understand the content in each 

small section by using  short, clear sentences and short paragraphs.
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Write  Short, Clear Sentences

•Express 1 idea per sentence. 

•Write in short sentences (no more than 15-20 words).

•Reduce punctuation as much as you can.
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Write Short Paragraphs

•Limit each paragraph to 1 topic.

•Write short paragraphs (no more than 150 words, in 3 – 8 sentences).

•Separate your paragraphs with ample white space to emphasize 

different paragraphs, different ideas.
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Write Short Sections

•Break up material into short sections.

•Add headings for each that give the reader a clear picture of what’s in 

that section.

•Short sections with useful headings allow the reader to skim and scan 

your document.
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Part III. Readable by Assistive Technologies

❑True headings

❑True lists

❑Page numbers

❑Alternative text

❑Descriptive hyperlinks
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❑Accessible tables

❑Identified document 

language

❑Exporting to PDF while 

preserving accessibility



ELECTRONIC DOCUMENTS

• Electronic documents can be read by assistive 

technologies such as screen readers or Braille 

devices. 

• Use the following built-in software tools when 

creating your electronic documents to assure 

they are accessible.



Different software, but similar tools

Although the built-in tools of each writing software program (or different 

versions of a program) may vary slightly, the steps required to use them are 

similar.

Writing Software Programs Examples:

•Microsoft Word

•PowerPoint

•Adobe PDF
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In addition to what’s following next in this lesson:

• Check out these videos from Microsoft Office if you would like to learn more about 
Adding Alt Text for Images or Identifying Document Language.

• To learn more about creating true headings, true lists, page numbers and descriptive 
hyperlinks, check out this video by Algonquin College. 

• This video by Wake Tech eLearning Support will show you more about Structuring an 
Accessible Table in Microsoft Word or PPT.

• Here is a helpful website on Fixing Inaccessible PDFs Using Acrobat Pro from the 
University of Washington. 

Where can I learn more about making Word 
documents accessible?

https://www.youtube.com/watch?v=IhL6ulpfteM
https://www.youtube.com/watch?v=wilTQsUZOOE
https://www.youtube.com/watch?v=dC8sfkQJcpA
https://www.youtube.com/watch?v=dC8sfkQJcpA
https://www.youtube.com/watch?v=cTliiBW_Jg8
https://www.youtube.com/watch?v=cTliiBW_Jg8
http://www.washington.edu/accessibility/documents/pdf-acrobat/


Accessibility Tools Used in Word

❑ True headings

❑ True lists

❑ Page numbers

❑ Alternate text

❑ Descriptive hyperlinks

❑ Accessible tables

❑ Identified document language

❑ Exporting to PDF while 

preserving accessibility

91
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Use True Headings

• Centering, enlarging and bolding a 

line of text does not create a true 

heading. 

• Identify true headings and 

subheadings by using the built-in 

heading features of the writing 

software.



The use of true headings and subheadings is required 
to create an accessible structure 

True heading structures enable Braille and 

screen reader users to:

• Understand how the page is organized

• Skim and scan the document

• Go directly to the information they need by 

jumping quickly between the heading 

structures with a single key-stroke.



How to create a True Heading in Word
Steps:  

1. Highlight the line of text you want to identify as the top heading.

2. Select Headings 1 from the built-in Headings Styles tool.



True Headings and Subheadings form an outline of the 
page content 

•Headings 1 are titles 

•Headings 2 are subtitles for Headings 1 

•Headings 3 are subtitles for Headings 2, etc.



How do I check the outline of my document by 
using True Headings?

The Navigation Pane displays all your 

headings and subheadings, and allows 

you and your readers to navigate 

through a structural view of your 

document. 

To view the Navigation Pane:

1. Click on the View tab 

2. Then check the Navigation Pane box



What if I am using an older version of Word?

In older versions, the  Document Map 

allows you to navigate through a 

structural view of your document. 

To view the Document Map:

1. Click on the View tab 

2. Then check the Document Map box



Use True Lists

• Any content organized as a list should be created as a true 

list, using the software’s built-in tools.  Lists that are not 

created by using these tools are not true lists.

• Only True lists allow screen reader users to understand how 

the content is organized. 

• When screen reader users come across a list, their screen 

reader will inform them that they are on a list and how many 

items are in that list.  This helps them to skim and scan.



How do I create a true list in Word?

• Look in the Paragraph group on the 

Home tab

• Select a bulleted or numbered list

• Use numbers only if there is a 

sequence to identify, such as 

priorities or steps in a process



Add Page Numbers

To  add page numbers:

1. Select the Insert tab

2. Find the Header and Footer group  

3. Click the Page Number drop down 

menu

4. Choose from the available styles of 

page numbering

Number your pages to allow for easy navigation and referencing.



Add Alternate Text for Images

• The purpose of alternative text, often abbreviated 

alt text, is to communicate the content of an image 

to people who can’t see it. 

• When screen readers encounter an image with alt 

text, they typically announce the image then read 

the alt text.

• Be succinct – provide just enough text to 

communicate the idea.



1. Right mouse click on the image

2. Select Format Shape

3. Open the Alt Text box 

4. Type in the description of the image

How do I add alternative text in Word?



• If images are purely decorative and contain no 

informative content, they do not require a 

description.

• Images that require a more lengthy description, 

such as charts and graphs, may require 

additional steps beyond adding alt text.

Which images don’t need alternate text?



Use Descriptive Hyperlinks

•Screen reader software announces the presence of links, allowing users to 

quickly skip from link to link by pressing the tab button.

•So providing hyperlinks that make sense when read out of context is 

important.  

•If your hyperlinks cannot be understood out of context, users may miss 

important information.



How does a screen reader user hear hyperlinks?

Which example would be easier for you to understand out of context?

Examples:

link click here

link https://www.youtube.com/watch?v=dC8sfkQJcpA 

link Creating Effective Hyperlinks

https://www.youtube.com/watch?v=dC8sfkQJcpA


Descriptive hyperlinks provide users with 
context

Don’t Write Do Write

To learn more about writing effective 
hyperlinks: click here

Learning how to write a more effective 
hyperlink can be confusing, but you can 
learn more by visiting Creating Effective 
Hyperlinks.

To learn more about creating effective 
hyperlinks select the following link:  
https://www.youtube.com/watch?v=dC
8sfkQJcpA 

•Extraneous words such as click here and descriptions before a URL should 

be avoided.

•The link itself should explain where the link will take them.

https://www.youtube.com/watch?v=dC8sfkQJcpA
https://www.youtube.com/watch?v=dC8sfkQJcpA
https://www.youtube.com/watch?v=dC8sfkQJcpA
https://www.youtube.com/watch?v=dC8sfkQJcpA
https://www.youtube.com/watch?v=dC8sfkQJcpA


How do I add descriptive hyperlinks in 
Word? (Steps 1-3)
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1. Highlight the word or phrase 

that describes the link.

2. Right mouse click

3. Select Hyperlink



How do I add descriptive hyperlinks in Word? 
(Steps 4-5)

109

1. Set the Link to -   Existing 

File or Web Page

2. Paste the desired URL link 

into the Address box.
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Use Accessible Tables

• Need to structure information or 

data into rows and columns?

•  Use an accessible table to help you 

to organize the presentation of your 

content in a way that is accessible to 

assistive technology users.



How do I make data tables accessible to screen 
reader users in Word?

1. Select the insert tab 

2. Click  the table icon

3. Hover the mouse over the squares to see a 

preview possible table dimensions

4. Click when you've reached the desired 

number of columns and rows

5. Clearly identify column and row headers 

using the software’s built-in tools 



How do I clearly identify column and row headers 
using the software’s built-in tools? 

Follow the step by step 

instructions in slides 106-115 to 

learn how to clearly identify 

columns and row headers to 

make accessible data tables.
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Title the Table (Steps 1 and 2_

1. Hover the mouse over the table.

2. Look for plus sign on the top, left corner.  



Title the Table (Steps 3 and 4)

3. Right click the plus sign

4. Select Insert Caption.
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Title the Table (Step 5)
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5. Write the table’s title in 

the Caption box. 

 



The table’s title should describe the table’s content

• That title will appear above my 

table.

• Example:  I have titled my table, 

KanCare Programs.
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Identify the Header Row

• The header row is usually the 

first row in a table

• It contains the titles for each of 

the columns.

118



How do I create a header row? (Steps 1-3)

To Create a Header Row:

1. Highlight the first row, right 

click.

2. Select Table Properties

3. Select Row tab. 
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How do I create a Header Row?  (Step 4)

4. Check the box - Repeat as 

header row at the top of 

each page.
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Make sure rows don’t break across pages

• Uncheck the box – Allow row to break 

across pages.  

• This is helpful in cases where the table 

reaches the bottom of the page. 

• The last row will move to the top of the 

next page, instead of breaking between 

the two pages, causing confusion.
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Adding Alt Text to Simple vs. Complex Tables in Word

• Select Alt Text tab (from Table 

Properties).

• Simple Tables: Enter the title of the 

table in the Description box.

• Complex Tables: If the table needs 

more explanation, write the 

explanation in the Description box, and 

a brief summary of the table in the Title 

box. 
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Our table is accessible, and ready for information 
to be entered



What to avoid when creating accessible tables in Word?

• Avoid merging and splitting cells.

• If the table is complex, consider whether you could divide 

it into multiple smaller tables with a heading above each.

• Keeping the table is as simple as possible will ensure that 

it is accessible. 



Identify Document Language

Screen reader software is 

multilingual, and can read content 

in a wide variety of languages. 



Identify Document Language

• Screen readers read the text aloud, using 
the pronunciation rules of the identified 
language. 

• To make sure  that screen readers are 
reading  the words in your document with 
the correct pronunciation, you should 
identify the  language of the document.



How to identify a document’s default language   
(Steps 1-3):

1. Select the Review tab

2. Select the Language button (from 

Proofing group).

3. Select the Set Proofing Language.



How to identify a document’s default language      
(Step 4):

4. Select the language for the 

entire document.



What is the cost of not identifying the correct 
document language?

•When text in one language is read with the pronunciation rules of another, 

the result is confusion. 

•To avoid this, be sure to identify the document’s default language, as well as 

any additional content written in a language other than the document’s 

default language.

•This will enable the screen reader to switch between language profiles 

without any adjustments from the user.
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When would there be more than one language 
throughout a document?

Possible Examples: 

• Kana greeted me with a quiet, 

“Ohayō gozaimasu,” as I walked in 

the door.

• Accessibility: We offer the following free 

options to help you understand these 

materials.

• Accesibilidad: Ofrecemos las opciones 

siguientes gratis para ayudarle a 

entender estos materiales.



How to identify foreign languages within a 
document

1. Highlight just the foreign 

words/phrases.

2. Select the Review tab

3. Select the Language button (from 

Proofing group).

4. Select the Set Proofing Language.

5. Select the language for just those 

words/phrases.
131



3/16/2024 132



Export documents to PDF while preserving 
accessibility

• There are right ways and wrong ways to export documents to PDF. 

• In order for an Adobe PDF document to be accessible, it must be a tagged 

PDF.

• For example, when you convert your accessible Word document to PDF, 

you’ll tag it with an underlying structure that includes all of the features 

described in this lesson.   



How to export from Word to PDF while 
preserving accessibility

• The goal is to export to PDF in a way that preserves the accessibility features of the 
Word document, including: true heading structures, true lists, alternate text,  accessible 
tables, identified document language, as well as any other content that is important for 
accessibility. 

• The correct method of exporting to PDF will depend on which version of Microsoft 
Office you are using. 

• This lesson shows the steps for exporting from Word 2010 to PDF.  To see the steps for 
other versions of Word, check out the Creating Accessible PDFs from Microsoft Word 
tutorials from the University of Washington.

http://www.washington.edu/accessibility/documents/pdf-word/


What to avoid when exporting from 
Word to PDF

• Do not - Save As PDF from the File 

menu.  

•  Although you can save a Word 

document as a PDF with this method, 

this will not preserve the document’s 

accessibility features. 



The Correct Way to Export from Word to PDF 
(Steps 1-4):

1. Start with the Word document you’ve 

made accessible.

2. Select the File tab 

3. Select Save As

4.  Select PDF (instead of Word Document) 

from the choices provided in the 

dropdown box.



How to Export from Word to PDF (Steps 5-6):

5. Before saving, select Options 

6. Double check that the box - 

Document structure tags for 

accessibility is checked.



Are all accessibility features preserved during the 
export to PDF, if done properly?

• It is always best to start with a document you’ve already made accessible, 

then export to a tagged PDF, so at least most of the original document’s 

accessibility features stay intact when exported.  

• However, if certain accessibility features do not survive the export to 

PDF, accessibility features can be added back into the PDF, using Adobe 

Acrobat Pro.



What to do if an accessibility feature was not 
preserved during the export to PDF? 

• In Microsoft Word 2010 version, for example, identified document 

language settings do not survive when exported from Word to PDF. 

• In this case, you would need to add this accessibility feature back into the 

PDF using Adobe Acrobat Pro (if that accessibility feature is necessary).



How to add accessibility features directly to PDF 
in Adobe Acrobat Pro?

• Did you have any accessibility features that did not survive when exported to 

PDF?

• Here is a helpful website on Fixing Inaccessible PDFs Using Acrobat Pro from the 

University of Washington. 

• If you don’t have access to Adobe Acrobat Pro software, ask someone in your 

department for assistance.

http://www.washington.edu/accessibility/documents/pdf-acrobat/


Recap of Accessibility Tools Used in Word

❑ True headings

❑ True lists

❑ Page numbers

❑ Alternate text

❑ Descriptive hyperlinks

❑ Accessible tables

❑ Identified document language

❑  Exporting to PDF with  

accessibility  features persevered
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Accessibility Tools in PPT vs. Word

Although the built-in tools for Microsoft PPT (or different versions of PPT)  

may vary slightly from what is used in Microsoft Word, the steps required to 

use them are similar for the following features:
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❑ True headings

❑ True lists

❑ Page numbers

❑ Alternate text

❑ Descriptive hyperlinks

❑ Accessible tables

❑ Identified document language

❑  Exporting to PDF while preserving accessibility



You cannot create accessible data tables in PPT

• In PPT, rows and columns can be styled so the table 

appears to be accessible, but you cannot add 

content in a way that will be identified by a screen 

reader. 

• In other words, you can not title the table or 

identify the row header as you can in Word, making 

it accessible.

• If the PPT contains more than the simplest tables, 

consider saving the presentation to PDF and making 

the table accessible from Adobe Acrobat Pro. 

Column 1 Column 2

Column 1, Row 
1

C2, R2

C1, R2 C2, R2

C1, R3 C2, R3



What tool can I use instead of True Headings 
for PPT?

• The outline structure of your presentation is the foundation of it’s 

accessibility.  

• In Word, we created True Headings and Subheadings to help create a 

structural outline that makes navigation easier for the screen reader user.

• Although you cannot assign true heading levels in PowerPoint, it is still 

possible to provide structural cues.

• You can do this by controlling the reading order of your presentation.



How do I Control Reading Order of the PPT Presentation?

❑ Use Built-In Slide Layouts

❑ Put all Content in Content Placeholders

❑ Assign Unique Titles to Every Slide

❑ Use Outline View

❑ Use the Selection Pane
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Put all Content in Placeholders

Be sure to place all of your 

presentation’s content 

between the dotted content 

placeholders, provided in each 

slide layout.



Use the Built-In Slide Layouts

• PowerPoint contains  built-in slide layouts that you can apply to any 
slide. 

• When you use these layouts, and create your content in a  
Content Placeholder, screen readers will follow the correct 
order as they advance through each slide.

• This is one of the most important steps you can take to control 
the reading order of your presentation, ensuring that it makes 
sense to all readers.



How to Use the Built-In Slide Layouts

To use a pre-set slide layout: 

1. Go to the Home tab. 

2. Select New Slide.

3. Choose the layout that makes sense 

for the slide you want to create. 



Assign a unique title in each slide’s title 
placeholder

•This unique title will also appear on that slide in 

the Outline panel.  

•The title placeholder is the first thing a screen 

reader will find in a standard layout.

•This is almost  as powerful as assigning a heading 

level  (true headings and subheadings) to the title 

of the slide. 
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How do I See the Outline View?

To switch to Outline View:

1. See the panel on the left side of the 

PowerPoint window.  

2. There you will then see an outline of 

your presentation, slide by slide.



Consider Working in Outline View

Working from the outline view will enable you 
to keep on eye on the structure of your 
presentation as you build it.

For example:

• The very first slide should be the title of the 
presentation in the first Content Placeholder.  

• The second Content Placeholder on that same 
slide would likely show the name of your 
organization.



What if I Add Extra Content?

WORD ART

For Example:

• Image

• Text box

• Word Art



How do I ensure a slide’s reading order is correct?  
(Steps 1-3)

Steps 1-3:

1. From the Home tab

2. Select Arrange

3. Then Selection Pane

  



How do I ensure a slide’s reading order is correct?  
(Steps 4-6)

At first, the order may appear incorrect:

4. The item you want to be read first should be 

on the bottom.

5. The item you want to be read next should be 

just above it.

6. The item to be read last should be at the top.



How do I ensure a slide’s reading order is correct?  
(Step 7)

Final Step:

7. Move each item up or down to correct 

reading order.



What if I don’t want all content on the slide read by the 
screen reader?
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If you think it’s better that 

some of the slide’s content be 

hidden from the screen reader, 

you can hide those items.



How do I hide content from the screen reader?

158

Select Hide by clicking on the eye icon 

for each item you would like to hide 

from the screen reader.  



Can a screen reader user hear 
hidden content?

No.  If you were to hide the 3 images 

on the left, the screen reader user 

will only hear the text from the Title 

and the Content Placeholder.
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Why is using the selection pane so important to 
creating reading order?

• The placement of items on each slide does not 

make a difference to the order in which  the screen 

reader reads them aloud.

• However,  the order in which you add items to the 

slide does make a difference to the order in which  

the screen reader reads them aloud.



How does a screen reader read a slide’s 
content by default?

• Regardless of when you create your title, the title placeholder will 

always be set to be read first.  

• Regardless of when you create content in the body’s content 

placeholder, the body’s content placeholder will be read second.

• Each item after that, will be read in the order they were created.

…Unless you change the reading order manually using the Selection 

Pane as just reviewed in this section.



Should I Use the Built-In Slide Designs?

• You may use the built-in designs 

offered in PowerPoint, however 

please know that not all of these 

design options have accessible color 

contrast or other design elements. 

• Please make sure to choose a design 

that meets all the design 

considerations for accessibility.



Problem with PPT’s Built-In Slide Designs?

Reminders on Readability:

• High contrast between text and background 

make it easiest to read (black text on white 

is easiest to read for most readers)

• Reduce distractions by not using 

watermarks or complicated background 

designs.



Avoid Animations & Transitions

Why should animations, fancy text fly-ins 

and slide transitions be avoided?

• They can be distracting.

• May not give users enough time to read 

slide content.

• Can cause screen readers to re-read slides 

or to read parts of a slide out of order.



Don’t use sounds, animations or transitions 

• Moving text, zooming words, letters that fly in from 

the side of the screen are all difficult to read.

• If you want to use an effect, Appear is acceptable, 

but please use sparingly. 

• But do not attempt to dazzle the audience with crazy 

font tricks. 

• They distract the reader from what you are really 

trying to say.



What if I have embedded videos in my PPT?

Make sure your embedded videos contain the following accessibility 

features:

1. Captioned Video with accessible player controls

2. A Transcript (if an audio only file)

3. An Audio Description 

We will discuss each of these items in detail in the Creating Accessible 

Videos portion of this presentation.
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When do I need to convert PPT to PDF?

• If a PowerPoint is to be distributed or posted on the internet,  it will be accessible to 

more people if you convert it to PDF. 

• Individuals using an older version of PPT may be required to convert your PPT into 

that older version in order to open it.  Certain accessibility features may be lost during 

this process.

• Others may be using Internet browsers that require them to locate, download, and 

install a special plug-in before they can run your presentation.   Even then, that plug-

in may provide only visual access to the slideshow, meaning it may not be accessible 

to screen reader users. 

• PowerPoint files can also be very large.  Converting PPT to PDF will reduce the file size 

and make it easier to distribute.



How to Correctly Convert PPT to PDF (Steps 1-3)

To save the accessibility features you’ve 

added to your original PPT, save it as a PDF 

using the correct steps:

1. Choose the Save As option

2. Choose PDF as the file type from 

dropdown box

3. Click on the Options button



How to Correctly Convert PPT to PDF  (Steps 4-5) 

4. Check both boxes in the Include 

non-printing information section:

❑ Document properties

❑ Document structure tags for 

accessibility

5. Click OK to close then Options box, 

then save.



Which accessibility features will stay intact from the 
PPT when converted to PDF?

For example:

❑True Lists

❑Alt Text

❑Page Numbers

❑Descriptive Hyperlinks 

❑Identified Document Language

❑Controlled Reading Order

All the accessibility features you created in your original PowerPoint will 

remain intact when converted to PDF by following these steps.



How do I double check for accessibility before I 
publish?

• There are several ways to test a document’s accessibility prior to its 

distribution.

• Many versions of Microsoft PowerPoint have a built-in accessibility 

feature.   Keep in mind that you should not rely solely on this feature to 

test for accessibility, but it is a good starting point.



How do I use the built-in accessibility feature?

To access the Accessibility Checker in 

Microsoft PowerPoint 2010:

1. From the File tab

2. Click on Info

3. Click Check for Issues

4. Select Check Accessibility from 

dropdown box



Why does the Accessibility Checker Task Pane have 2 
sections?

1. Inspection Results - Identifies the 

accessibility issues.

2. Additional Information  - If you click on 

a specific issue in the top section, here 

you’ll  see the details on why it’s is a 

problem and tip on how to fix it.
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What’s the difference between errors, warnings 
and tips?

They indicate content that:

1. Errors :  people with disabilities are unable 

to read (the most serious problem)

2. Warnings: people will find difficult to read

3. Tips:  people might find difficult to read
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What steps do I take after using the built-in 
Accessibility Checker?

• Although the Accessibility Checker (in Word, PPT, 

Excel or PDF) can find a variety of issues, it cannot 

find every possible error.

• If you get an “all clear” from the software’s 

Accessibility Checker, you still need to follow all 

parts of the KanCare Ombudsman Guidelines for 

Creating Accessible Documents and Presentations.



Summary:  Double Check for Accessibility

1. Start by following the KanCare Ombudsman Guidelines for Creating 
Accessible Documents and Presentations.

2. Once the original document is complete, use the writing software’s 
Accessibility Checker.

3. If converting to PDF, you must also use Adobe PDF’s Accessibility Checker to 
ensure no accessibility features have been lost in the conversion.

4. As a final test, you can use a screen reader such as JAWS, NVDA, WindowEyes, 
etc., to test it yourself. 

 - Or develop an Accessibility Testing team of persons experienced at using 
Assistive Technologies. 



What if I don’t have Microsoft 2010?

• Although the built-in accessibility tools for different versions Microsoft 

PPT may vary slightly from what is presented in this lesson, the steps 

required to use them are similar.

• Check out Word 2013 & 2016: Using the Accessibility Checker, a helpful 

video on Word, Excel and PPT from the Texas Governor's Committee for 

People with Disabilities. 

https://www.youtube.com/watch?v=siochpC2Dlw


Check Content for Accuracy before Publishing

•After you’ve created your document or presentation, send back to the 

expert for their review and feedback.

•Ask them to point out any content errors or areas of confusion, so that 

you can make your information correct and clear to your audience.

•Allow yourself enough time for the expert to review your work, give 

you feedback, and for you to make any requested changes.
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Consider Creating a Default PPT Template

•Make sure to use fonts consistently within a document as well. 

•Consider creating your own PowerPoint template file so that the font 

you’ve chosen for your headers and body text all have the same colors, 

sizes, spacing, etc. every time.

•You then only need to tweak individual slides when necessary.
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How to create a default font for headings 
and body text (steps 1-6)

1. Go to the View tab

2. Select Slide Master

3. Click on Fonts

4. Choose your heading and body text fonts from the dropdown box

5. Highlight the heading

6. Click the left justify button (so headings will be justified to the left)
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How to create a default font for headings 
and body text (steps 7-11)

7. Choose bold (so every heading will be bolded automatically)

8. Select the body text 

9. Make whatever default setting you like, including line spacing

10. In the ribbon, select Close Master View

11. Save one template as blank, so that you can use this as your default 
template
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Creating Accessible Videos
Will be added to KanCare Ombudsman         

Accessible Guidelines soon...



Creating Accessible Videos

Videos should be produced and delivered in ways that ensure that all 

members of the audience can access their content. 

Accessible Videos include all of the following:

1. Video Captions (Subtitles)

2. Transcript

3. Audio Description 

4. Delivered in an Accessible Media Player



Part IV.  Available in Alternative Formats

❑Braille and Enlarged print

❑Documents on CD

❑Print in Languages other than English

❖Will be added to KanCare Ombudsman 

Accessible Guidelines soon.
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Resources

•Plain Language

•Easy Read Documents

•Practical Typology
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